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Foreword 
 

 

QGIS (http://www.qgis.org/) is an Open Source Geographic Information System 
licensed under the GNU General Public License. The project was born in May 2002 
and was then established as a project on SourceForge. QGIS is now an official project 
of the Open Source Geospatial Foundation (OSGeo: http://www.osgeo.org). 

 

 

 

QGIS allows users to view, manage, edit and analyze spatial information, in addition to 
composing and exporting maps. Among GIS software, QGIS is simple to use and intuitive. When 
it was created, QGIS only offered the main functionalities, but it benefits from a very active community 
and is evolving rapidly. Today, it has become an essential GIS software, among the most powerful 
and complete. 

 

QGIS has the advantage of running under different systems: Linux, Unix, Mac OSX, Windows and 
Android. It supports many vector, raster and database formats and functionalities. It has an ever-
increasing list of features through a powerful plugins system. QGIS integrates with other open-source 
GIS packages, including PostGIS, GRASS, MapServer, GeoNode.  

 

QGIS is maintained by volunteer developers who release updated versions every four months and 
many plugins. Older versions are still available for download. An LTR (Long Term Release) version is 
released approximately every 2 years. The latest release is QGIS 3.6 (called Noosa) 

 

 

 
  

http://www.osgeo.org/
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Useful links 
 

 

QGIS tutorials (QGIS 3.6) 

QGIS official Training Manual: http://docs.qgis.org/latest/en/docs/training_manual/index.html 

QGIS Tutorials and tips, by Ujaval Gandhi.: https://www.qgistutorials.com/en/ 

Introduction to GIS Fundamentals, by Datapolitan: http://training.datapolitan.com/qgis-
training/Introduction_to_GIS_Fundamentals 

 

 

QGIS tutorials in French (QGIS 2.18): 

Tutorial created by “pôle Analyse et Représentation des données de l'UMR PASSAGES”. 

http://ouvrir.passages.cnrs.fr/tutoqgis/ 

 

 

 

 

Spatial data 

Several websites providing free spatial data are listed here: 

https://www.netvibes.com/geohealth?#Online_databases 

 

 

For more information on GeoHealth researches, follow: 

https://www.facebook.com/geohealthresearch/ 

 

  

http://docs.qgis.org/latest/en/docs/training_manual/index.html
https://www.qgistutorials.com/en/
http://training.datapolitan.com/qgis-training/Introduction_to_GIS_Fundamentals
http://training.datapolitan.com/qgis-training/Introduction_to_GIS_Fundamentals
https://www.netvibes.com/geohealth?#Online_databases
https://www.facebook.com/geohealthresearch/
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1. Installing and starting QGIS 

1.1. Downloading and installing QGIS 

 The latest version is QGIS 3.6, called Noosa and published on February 2019 

 The latest Long Term Release (LTR) is QGIS 3.4, called Madeira and published on October 
2018. 

 

 Download from QGIS website: 

https://qgis.org/en/site/forusers/download.html 

 

  The installation does not raise any particular difficulties 
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1.2. Starting QGIS 

 Use the QGIS shortcut on desktop :  QGIS Desktop 3.6.3 

 Or go to: Startup menu / All Programs / QGIS 3.6 / QGIS Desktop 3.6.3 

 

The QGIS graphical interface is divided into 6 zones: 

1. Menu Bar 
2. Toolbars 
3. File browser 
4. Layers, Legends 
5. Map canvas 
6. Locator bar 

 

 

 

Note : The graphical user interface may appear differently depending on your operating system and 
configuration of toolbars. 

 

The available toolbars depend on the installed plugins. 

Panels and toolbars can be displayed or hidden by: 

 right-clicking in the grey area of the toolbars to open the panel selection (top list) and toolbar 
selection (bottom list). 

 Going to the View Menu / Panels or View / Toolbars 
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1.3. Specifying QGIS options 

QGIS is developed in English but the GUI can be used in different languages according to the 
available translations. It is easy to switch from one language to another one: 

 Go to the Preferences / General tab 

 Select Override system locale if necessary and chose the translation 

 

 Verify also the units and date formats in the Locale list.  
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2. Creating a simple map and discovering the different toolbars 

2.1. Downloading dataset 

 

Cambodia administrative boundaries, divided in 4 levels: 

 level 0: country, 

 level 1: province / khaet and capital / reach thani, 

 level 2: municipality, district, 

 level 3: commune / khum, quarter / sangkat 

These contours maps (shapefiles) are made available from the Humanitarian Data Exchange (HDX), 
provided by OCHA (United Nations Offices for the Coordination of Humanitarian Affairs: 
https://www.unocha.org/). These maps were originally produced by the Department of Geography of 
the Ministry of Land Management, Urbanization and Construction in 2008 and unofficially updated in 
2014 according to sub-decrees on administrative modifications. They were provided by WFP - VAM 
unit Cambodia. 

You can download these administrative boundaries, as zip folders, here: 

https://data.humdata.org/dataset/cambodia-admin-level-0-international-boundaries 

 khm_admbnda_adm0_gov_20181004.zip (127.0K) 

 khm_admbnda_adm1_gov_20181004.zip (292.6K) 

 khm_admbnda_adm2_gov_20181004.zip (589.2K) 

 khm_admbnda_adm3_gov_20181004.zip (1.2M) 

 

Population data: 

Population data is available at these different levels from the Humanitarian Data Exchange (HDX) 
repository. It comes from the Commune database (CDB), provided by the Cambodia Ministry of 
Planning. 

https://data.humdata.org/dataset/cambodia-population-statistics 

 

Health Facility data: 

The Humanitarian Data Exchange (HDX) repository provides a dataset on the location of health 
facilities (Referral Hospitals, Health Centers, Health Posts). These maps were originally produced by 
the Cambodia Ministry of Health (MoH). 

https://data.humdata.org/dataset/cambodia-health 

 

Transportation data: 

The roads network is available from Humanitarian Data Exchange (HDX) repository. These maps 
were originally produced by the Cambodia Department of Geography of the Ministry of Land 
Management, Urbanization and Construction. They include: National road primary and secondary, 
Provincial road primary, Provincial and rural roads, Foot path, Cart track, Bridge line. 

https://data.humdata.org/dataset/cambodia-roads 

 

Hydrology data: 

The hydrological network is available from Humanitarian Data Exchange (HDX) repository. These 
maps were originally produced by the Cambodia Department of Geography of the Ministry of Land 
Management, Urbanization and Construction. They include: rivers (“Non-
Perenial/Intermittent/Fluctuating” and “Perennial/Permanent”), lakes 

https://data.humdata.org/dataset/cambodia-water-courses-0 

https://data.humdata.org/dataset/cambodia-admin-level-0-international-boundaries
https://data.humdata.org/dataset/7472f7e0-3deb-44d9-bd36-38237c666a2e/resource/0654e392-665b-47b4-8393-72d72dce9c72/download/khm_admbnda_adm0_gov_20181004.zip
https://data.humdata.org/dataset/7472f7e0-3deb-44d9-bd36-38237c666a2e/resource/3430bfcd-2a6c-446d-9dfd-6288c412d663/download/khm_admbnda_adm1_gov_20181004.zip
https://data.humdata.org/dataset/7472f7e0-3deb-44d9-bd36-38237c666a2e/resource/1f94c390-293e-40a7-a986-49c64e182b4e/download/khm_admbnda_adm2_gov_20181004.zip
https://data.humdata.org/dataset/7472f7e0-3deb-44d9-bd36-38237c666a2e/resource/76f6a16d-5933-467b-b1db-4c827c734696/download/khm_admbnda_adm3_gov_20181004.zip
https://data.humdata.org/dataset/cambodia-population-statistics
https://data.humdata.org/dataset/cambodia-health
https://data.humdata.org/dataset/cambodia-roads
https://data.humdata.org/dataset/cambodia-water-courses-0
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Digital Elevation Model (DEM) 

The SRTM (Shuttle Radar Topography Mission) is a free DEM provided by NASA and NGA (formerly 
NIMA). Space Shuttle Endeavour (STS-99) collected these altimetry data during an 11-day mission in 
February 2000 at an altitude of 233 km using radar interferometry. The SRTM covers nearly 80% of 
the land area from 56° South latitude to 60° North latitude. Spatial resolution is approximately 30 
meters on the line of the Equator. 

The SRTM data can be downloaded here: http://srtm.csi.cgiar.org 

 

  

http://srtm.csi.cgiar.org/
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2.2. Creating a project 

QGIS starts with an untitled project but displays in the canvas the list of recent projects. By double-
clicking on one of these recent projects, QGIS will quickly open it. 

 You can start by saving your future project (file extension .qgz) : 

In Menu Project -> Save as… 

or by using the File Toolbar  

Note: Remember to frequently save your project! 

 

2.3. Adding a vector layer 

Note: Vector layers can be points, polylines or polygons.  

 Add the four levels of Cambodian administrative layers (provinces, districts, communes) to 
the project: 

o khm_admbnda_adm0_gov_20181004.shp (country) 
o khm_admbnda_adm1_gov_20181004.shp (provinces) 
o khm_admbnda_adm2_gov_20181004.shp (districts) 
o khm_admbnda_adm3_gov_20181004.shp (communes) 

 

There are several ways to add data to the project 

1. By using the Data Source 
Manager 

a. Open the Data Source 
Mangager by clicking 
on its icon in the Data 
Source Manager 
Toolbar 

 

b. Select the type of data 
to open : Vector / Raster 
/ Delimited Text (csv) / 
etc. 

c. Browse to your file  
d. Click on Add button 

 

2. By using the Browser panel 
a. Find the .shp files in your folders 
b. Double-click the .shp files directly or drag and drop it to the map canvas 

3. By directly dragging and dropping the .shp files from your browser to QGIS 

 

Note: You can select and open several files together with Ctrl or Shift keys. 

Note: You can drag and drop layers in the table of contents to modify the order of appearance of 
the layers 
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2.4. Adding a basemap 

QGIS 3 makes it very easy to add background maps (OpenStreetMap, Bing, MapBox, Google, etc.). 
Of course, this requires Internet connection. 

 

Examples of basemap from different providers: 

 
Microsoft Bing Satelitte basemap 

 
Google Satelitte basemap 

 
OpenStreetMap basemap 

 
Stamen Toner basemap 

 

There are several ways to add basemaps to QGIS: 

1. By using the Browser panel: 

 In the Browser panel, go to XYZ Tiles and double click on OpenStreetMap 

 

2. By using a dedicated plugin: 

You can also get a large list of basemaps using the QuickMapServices plugin: 
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 Install QuickMapServices 
plugin by opening the Plugin 
Manager 

 Menu Plugins / Install and 
Manage Plugins… 

 Search for 
QuickMapServices (you can 
type “Quick” in the Search 
window) 

-> this plugin will be installed in the 
Web Menu 

 Go to Menu Web / 
QuickMapServices 

 Select the basemap you 
would like to display 

QuickMap Services Plugin offers also 
precise settings for the visibility of the 
maps in the plugin, for getting more 
maps or for the download timeout. 

 In the QuickMapServices 
Menu, go to Settings 

 Go to the More Services tab 

 Click on “Get contributed 
pack” to obtain more maps 

 

Note:  do not open too many 
basemaps since it will 
require internet  

 

Alternatively, you can use the OpenLayers Plugin that will be also installed in the Web Menu but it 
offers less possibilities. 

 

 

It is possible to add more basemaps in the 
XYZ Tiles Browser by connecting to other 
tile services 

See: 
https://opengislab.com/blog/2018/4/15/add-
basemaps-in-qgis-30 

 Right-click on XYZ Tiles in the 
Browser Panel 

 Select New Connection… 

 Enter the name and URL of 
basemap 
Example for Google Satellite: 
https://mt1.google.com/vt/lyrs=s&x
=%7Bx%7D&y=%7By%7D&z=%7
Bz%7D 

 

 

  

https://opengislab.com/blog/2018/4/15/add-basemaps-in-qgis-30
https://opengislab.com/blog/2018/4/15/add-basemaps-in-qgis-30
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There is also the possibility to use a Python script to directly add several basemaps to the Browser: 

 Copy the script here: 
https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsyst
em/python/qgis_basemaps.py 

 Open the Python Console in the Plugins Menu / Python Console 

 Paste the script and Run Python 

 It will automatically update the liste of XYZ tiles (Thanks to the contributors of this nice Python 
script!). 

 

 

 

 

2.5. Moving around the map 

Map Navigation toolbar  

Test the different tools: 

- Pan map, 

- Pan map to selection, 

- Zooming: Zoom In, Zoom Out, Zoom to Native Resolution, Zoom Full, Zoom to Selection, 
Zoom to Layer, Zoom Last, Zoom Next, 

- Refresh 

 
Control the scale and the geographic coordinates of the map: 

A specific scale can be given on the bottom right 
side of the window. 

Also you can visualize the coordinates of the 
location of the mouse over the main window. 

 

 

 

  

https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py
https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py
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2.6. Selecting and getting information on attributes 

Attribute toolbar  

 
Test the different tools: 

- Identify features: First select a layer in the Layer Panel 
and then click on the object to display its information. 

- Select Features: First select a layer in the Layer Panel, 
then choose between: 

o Select Feature(s), 
o Select Features by Polygon / by Freehand / by 

Radius 
o Select Features by Value 
o Deselect Features from all layers. 

- Open Attribute Table: First select a layer in the Layer 
Panel and then click on this icon to display its table. 

- Open Field Calculator 
- Open Processing Toolbox 
- Show Statistical summary 
- Measure Line / Area / Angle 
- Show Map Tips 
- New Bookmark 
- Show Bookmark 
- Annotation: Text / Form / HTML / SVG / Move. 

 
 

2.7. Adjusting the symbology 

 

 Choose 
khm_admbnda_adm1_gov_20181004
.shp 

 Double click on the name of the layer to 
open the Layer properties window 

 Choose the Symbology tab 

 Here you will be able to select Single 
symbol / Categorized / Graduated / 
Rule-based / Point displacement 

 Choose Categorized, choose the 
HRName column and click on Classify 

 See the different options, with colors, 
and layer rendering 

 

 

 

Alternatively, you can open the Layer Styling Panel 
with the shortcut in the top of the Layers Panel. 
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2.8. Choosing layer units 

You may like to display your map either in “Degrees, Minutes, Seconds”, in “Decimal degrees” or in 
Meters. 

 Go to Project / Properties / Tab General 

 

 

2.9. Using projections 

QGIS allows to define a Coordinate Reference System (CRS) by default or for the whole project, for 
layers without predefined CRS. It also allows to define customized CRS and allows the projection of 
vector layers on the fly. 

. 
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Notes: Layers should be in the same CRS to allow geoprocessing. Indeed, we will have to check 
and pay attention to the CRS of each layer when using them for spatial analyses. However 
QGIS can display layers with different CRS on the same extent. 

 Layers should use a projection in meters, when calculating distances or buffers. 

 

QGIS manages approximately 2,700 CRS. 

For this training using data from Cambodia, we will use the following projections: 

 Geographic CRS (in decimal degrees): WGS 84 (EPSG:4326) 
-> This CRS has a worldwide coverage and is used for Google and OpenStreetMap data. 

 Global projected CRS (in meters): WGS 84 / UTM zone 48N (EPSG:32648) 

 Local projected CRS (in meters): Indian 60 / UTM zone 48N (EPSG:3148) 

 

Specify the CRS of a layer: 

 Double click on the name 
of the layer to open the 
Layer properties 
window 

 Choose the Source tab 

 Click on the Select CRS 

button  

 Choose the desired 
projection from the top 
list if it appears among 
those recently used, 
otherwise from the 
bottom list. 

 Use the filter if the 
desired projection does 
not appear in the top list. 

 You can save the layer 
with a new projection: 
this is the way to 
reproject a layer.  

Exercise: 

 Check the CRS of your administrative 
files (WGS 84). 

 Reproject them into Local projected 
CRS (Indian 60 / UTM zone 48N): 

o Right-click on the name of the 
layer 

o Export / Save Features As… 
o Browse to your folder and 

give a new name indicated 
they are reprojected. 

o Choose the new CRS 
o OK 

 
Specify the SCR of a project: 

 Go to Project / Properties 

 Select the Coordinate Reference System 
(CRS) tab 

 Choose the desired CRS 
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3. Using vector data 

 

3.1. Downloading OpenStreetMap data 

 
OpenStreetMap (OSM: www.openstreetmap.org) is an open-access geographic database of the 
World. You are free to use it for any purpose as long as you credit OpenStreetMap and its 
contributors. 

The QuickOSM plugin, developed by Etienne Trimaille at 3Liz, is the easiest way to access OSM data, 
through the Overpass API. Users can directly request OSM features over a given extent, by defining 
the keys, values and boundaries in the Quick Query tab. Users can choose to act directly on the script 
to best configure their request after clicking on the “Show query” button. 

 

 Install QuickOSM from the plugins manager 

 

Exercise: Download the hospitals of Cambodia 

 Go to Vector / QuickOSM / QuickOSM 

 In the Quick query, choose: 
o Key = amenity 
o Value = hospital 
o In = Cambodia 
o Run query 
o Data will be downloaded as polygon and points shapefiles 

 In the “Advanced” list, you can choose the type of data to download (Node / Way / Relation / 
etc.) or increase the timeout if necessary 

 Export the downloaded data as shapefile for further uses 

 

Note: Clicking on the “Help with key/value” will directly open the Map Features page of the OSM 
wiki: https://wiki.openstreetmap.org/wiki/Mapfeatures 

 

For administrative boundaries, check here the administrative levels by country: 
https://wiki.openstreetmap.org/wiki/Tag:boundary%3Dadministrative#10_admin_level_values_for_spe
cific_countries 

 

https://wiki.openstreetmap.org/wiki/Mapfeatures
https://wiki.openstreetmap.org/wiki/Tag:boundary%3Dadministrative#10_admin_level_values_for_specific_countries
https://wiki.openstreetmap.org/wiki/Tag:boundary%3Dadministrative#10_admin_level_values_for_specific_countries
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3.2. Joining a data table to a map 

In this exercise, we will join the population data (khm_pop_2016_adm3_v2.csv) to the layer of 
communes khm_admbnda_adm3_gov_20181004.shp based on a common field. 

1. Add the layer khm_admbnda_adm3_gov_20181004.shp to the map 

2. Add the table khm_pop_2016_adm3_v2.csv the project. It cannot be directly added by 
double-click because settings should be carefully checked to ensure a good data format: 

a. Open the Data Source Manager , choose the “Delimited Text” tab and browse to 
your csv file 

b. Precise the file format (here, we use custom delimiters and check “Comma”). Also 
this file has no geometry (Check “No geometry”). Press “Add”. 

 

 

When opening this file with the 
Open Attribute Table button 

 (or by right-clicking on its 
name), you can verify that the 
data attributes (M, F, T) are in 
a numeric format (right 
alignment). 

 

You can also verify the type of 
each attribute by opening the 
Layer Properties window 
(double-click on the name of 
the table) and opening the 
Source Fields tab. 

 

3. Open the Layer Properties window (double-click on the name of the table) of the shapefile in 
which you want to join the table 

4. Open the Joins tab and click on the “Add New Join” button (green + button)  to add the 
table 

5. Select: 

a. Join layer = khm_pop_2016_adm3_v2.csv 
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b. Join field = ADM3_PCODE 
c. Target field = ADM3_PCODE 
d. Check the “Custom Field Name Prefix” and choose a short prefix such as “pop”, 

otherwise the name of the joined attributes will be too long 
e. OK 

 

6. Check that the join has enriched the attribute table of the communes layer. 

7. Save this new layer under a new name to permanently record the information in the attribute 
table 

8. Choose a symbology to display population data: 

a. Open the Layer Styling panel 

b. Choose “Graduated” for a continuous variable, and select the column to display 

c. Choose a “Color ramp”, a “Mode” (Equal Interval, Quantile, Natural Breaks, Standard 
Deviation, Pretty breaks) and click on “Classify”, then “Apply” 
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3.3. Creating new attributes in the attribute table 

In this exercise, we will calculate the population densities from the Commune layer, which has been 
enriched with the population data per commune. It will first be necessary to the surface areas of 
each municipality and then divide the population by the surface area: 

 Open the Attribute Table of the Commune layer 

 We will use the buttons above the table dedicated to editing the table: 

 

 First click on the pencil to activate the edit mode, the other buttons then become accessible. 

 Click on the Open Field Calculator button  

 Choose create a new field for Population 
density as Decimal number 

 Choose from the Fields and values list 
the attribute for Total population "popT" 

 Choose the function: here in the 
Geometry list, double click on $area 

 Write the expression: "popT" / $area * 
1000000 (multiply by 1 million to have 
the densities in sq. km) 

 The output preview shows that the 
calculation is indeed consistent 

 Click OK 

 Finally click on the Pencil button to exit 
the editing mode and Save. 

Note: When you switch to edit mode of the 
attribute table, it is also the shapefile 
that can be modified. 

 

 Check consistency in the population field of the attribute table or by displaying on the map. 

 

 

3.4. Creating a map from a selection of entities 

 

Exercise: Create a map of Phnom Penh 
Municipality (province) 

 Open the province shapefile: 
khm_admbnda_adm1_gov_20181
004.shp 

 Select Phnom Penh  

 Right click on the layer name and 
choose Export / Save Selected 
Features As… 

 Choose the ESRI format, the 
destination of your new shapefile, 
name it 

 OK 

 Zoom on the extent of this new 
map by right clicking on its name 
and choosing “Zoom to layer” 
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3.5. Intersecting vector layers 

 

QGIS offers a set of geoprocessing 
tools available in the Vector menu. 

 

Exercise: Extract health facilities in 
your province of interest (example of 
Phnom Penh) 

 Add the shapefiles of the 
referral hospitals and of the 
health centers to your map 
canvas and check their CRS (-
> Indian 60 / UTM zone 48N) 

 Add the shapefile of one 
province (here we take Phnom 
Penh) and check its CRS (-> 
WGS 84) 

 Project this shapefile into the 
local projected CRS 

 Go to the Vector Menu / 
Geoprocessing tools / 
Intersection… 

 Input layer = 
khm_hltfacp_referral_gov.shp 

 Overlay layer = 
Phnompenh_ind.shp 

 Intersection: browse to your 
folder and choose a name for 
the resulting intersection 
shapefile 

 Run 
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3.6. Creating a layer from GPS coordinates 

 
Exercise: Create a shapefile from a csv file containing the longitude and latitude of Phnom Penh 
hospitals (as referred in OpenStreetMap). 

 Open the Data Source Manager , choose the “Delimited Text” tab and browse to your 
csv file: Hospitals_OSM_PhnomPenh.csv 

 Precise the file format (here, we use custom delimiters and check Comma) -> the table 
should be readable in the “Sample Data” box 

 Precise the geometry: check “Point coordinates” and indicate the X and Y fields 

 Precise the CRS of these points 

 Press “Add” 

 Save these imported points as a shapefile: right-click on the name of the imported file, 
choose Export / Save features as… 

 

 

 
  



   

 

23 

3.7. Creating buffer zones (buffers) 

 

For the creation of buffer zones, we need a CRS in meters. 

Exercise: Create buffers zones around health facilities 

 Add the hospital layer to the canvas: khm_hltfacp_referral_gov.shp 

 Check its CRS (-> Indian 60 / UTM zone 48N) 

 Go to Vector menu / Geoprocessing Tools / Buffer… 

 Choose Distance (for example here 10 kms), whether the overlapping buffers are dissolved or 
not, and a place to save your Buffered shapefile 

 Run 

 

 

 

 

Example of separated buffers 

 

Example dissolved buffers 

 

Note: Buffer zones can be created from any type of vector file (points / lines / polygons). The 
buffer zones will always be polygons.  
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3.8. Calculating distances between points (distance matrices) 

A dedicated QGIS function allows you to directly calculate distances between two layers of points. 

 

Exercise: Calculate the distances between the locations of the fictive patients (QGISfever.shp) 
and referral hospitals (khm_hltfacp_referral_gov.shp). 

As with the creation of buffer zones, we need a CRS in meters to calculate distances. 

 Go to Vector Menu / 
Analysis Tools / Distance 
Matrix… 

 Choose the two point layers 
(containing n cases and m 
infrastructures) 

 Choose the type of matrix: 
o Linear distance 

matrix where all 
combinations will be 
in line (n*m lines) 

o Standard distance 
matrix (with n rows 
and m columns) 

 Specify the name and 
location of the output 
distance matrix. This matrix 
will be in.csv format 

 

 

3.9. Calculating the number of points in a polygon 

This function is very useful in epidemiology for calculating, for example, the number of cases per 
administrative unit. 

 

Exercise: Calculate the number of “QGIS fever” cases in each district of Phnom Penh 

 Reproject the district layer in the local 
projected CRS (Indian 60 / UTM zone 48N) 

o Right-click on the name of the layer 
o Export / Save Features As… 
o Browse to your folder and give a 

new name indicated they are 
reprojected. 

o Choose the new CRS 
o OK 

 Clip the district layer to the extent of 
Phnom Penh province: 

o Go to Vector Menu / Geoprocessing 
Tools / Clip… 

o Choose the district layer as the input 
layer 

o Choose the Phnom Penh layer as the 
overlay layer 

o Browse to your folder and give a 
name to the clipped layer 

o Run  
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 Analysis Tools / Count Points in Polygon… 

o Choose the district layer as Polygons 

o Choose the QGIS fever layer as Points 

o See the possible options to Weight fields (not used here) 

o Specify a file name and folder for your output shapefile. 

 

 
 
You can then represent the number of cases in each district by playing with the symbology 
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3.10. Exporting a layer to Google Earth 

 

Note:  This export could be useful when 
you want to exchange files with 
colleagues who do not know how 
to use a GIS, but who know the 
possibilities of Google Earth. 

 

 

 Right-click on the name of your layer 
and choose Export / Save Features 
As… 

 Choose the KML (Keyhole Markup 
Language) format 

 Select the folder and name of your 
kml file to save 

 OK 

 

This kml file can be opened in Google Earth. 
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4. Using raster data 

In this exercise, we will use a Digital Elevation Model (DEM), called SRTM (Shuttle Radar Topography 
Mission), provided by NASA and NGA (formerly NIMA). 

 

4.1. Opening and displaying raster data 

 Open the Data Source Manager , choose the “Raster” tab and browse to 
srtm_cambodia.tif 

 Double-click on the name to open the Layer Properties, and go to the Symbology tab 

 In Render type, choose “Hillshade” and Apply to view the Elevation data with shadow 

 Try also the “Singleband pseudocolor” for a color view. You can adjust the classification 
mode and increase the number of classes. You can choose the color ramp and invert colors. 

 

 

4.2. Clipping a raster 

QGIS offers the possibility to cut a raster 
according to the contour of vector layers. 

 

Exercise: Extract the SRTM on Mondolkiri 
province (east of Cambodia) 

 Create a shapefile layer of Mondolkiri 
o Open the province layer: 

khm_admbnda_adm1_gov_2018
1004 

o Select Mondolkiri province 
o Right-click on the name of the 

layer / Export / Save Selected 
Features As… 

o Browse to your folder and save 
the Mondolkiri.shp layer 
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 Raster / Extraction / Clip Raster by Mask Layer… 

 Input layer = srtm_cambodia.tif 

 Mask layer = Mondolkiri.shp 

 Run 

 

4.3. Changing the projection of a 
raster 

 

The DEM srtm_cambodia.tif is in WGS84 with 
units in decimal degrees. To make some 
calculations related to distances, we will need 
the meter as a unit. It is therefore necessary 
to reproject our raster. 

 

Exercise: Reproject the Mondlkiri DEM in 
the local projected CRS 

 Go to Raster Menu / Projections / 
Warp (Reproject) 

 Input layer = srtm_Mondkiri.tif 

 Target CRS: choose the local 
projected CRS 

 Browse to your folder and give a 
name to the Reprojected raster 

 Run. 

 

 

 

4.4. Deriving information from DEM: slopes, aspect, hillshading, contours 

 

Several tools are provided in the Analysis Menu 
from the Raster Menu 
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Exercise: Calculate slope and aspect in Mondolkiri province 

 Go to Raster Menu / Analysis / Slope… 

 Choose the Mondolkiri DEM 

 Browse to your folder and give a name to the raster of slopes 

 Run 

 The same applies to the calculation of exposure (aspect) and hillshading. 

Note: Calculating the slope in QGIS is simple. The output is also a raster of the same 
resolution (90 meters) as the source raster. 

 

 

Slope 

 

Aspect 

 

 

Exercise: Calculate the contour lines of Mondolkiri province 

 

 Go to Raster Menu / 
Extraction / Contour… 

 Choose the Mondolkiri 
DEM 

 Choose the interval 
between lines = 100 meters 

 Browse to your folder and give a 
name to the shapefile of contour 
lines 

 Run 
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4.5. Raster calculator 

The raster calculator allows you to make calculations between several rasters or on the values of a 
single raster. 

 

Exercise: extract the DEM over 500 meters high 

 Open the raster calculator: Raster / Raster calculator… 

 Select the Mondolkiri raster 

 Browse to your folder and give a name for the output layer 

 Raster Calculator Expression: Double-click the raster name in the “Raster Bands” list to enter 
its name in the expression then write “> 500” 

 OK 
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4.6. Downloading and using Sentinel-2 images 

 

Browse and download Sentinel-2 images 

We will use here the EO Browser provided by Sentinel Hub and developed by Sinergise: 

https://apps.sentinel-hub.com/eo-browser/ 

 

Exercise: download and display a Sentinel-2 image from Phnom Penh 

 Open the EO Browser and search for Phnom Penh in the top right search box. Zoom the map 
to Phnom Penh 

 Choose Sentinel-2 L1C as Data source, reduce the maximum cloud coverage to 20% 

 Choose a time range and search 

 

 

 Choose one tile among the results and click on Visualize 

 Look at the different indices available to observe their distribution 

 

https://apps.sentinel-hub.com/eo-browser/
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 Click on the download icon  to get the weblink to download the chosen image 

 Download requires to be registered in the Copernicus Open Access Hub 
(https://scihub.copernicus.eu/) 

 

Display a Sentinel-2 image in 
True color 

 Add the raster bands 
of your Sentinel-2 
images: Menu Layer / 
Add Layer / Add 
Raster Layer… 

 Browse and choose 
the different bands to 
open B02 (Blue), B03 
(Green) and B04 (Red) 

 Miscellaneous / Build 
Virtual Raster… 

 Choose the 3 input 
layers 

 Run 

 Open the layer 
properties of your 
virtual raster and go to 
Symbology tab 

 Choose the correct 
bands for each color 
and click OK  

 

 

Exercise: Calculate the NDVI of this Sentinel-2 image from Phnom Penh 

The normalized difference vegetation index (NDVI) is a simple index that can be calculated from 
optical satellite images to show the vigor of vegetation. 

NDVI = (Near Infrared Band – Red 
Infrared Band) / (Near Infrared Band 
+ Red Infrared Band) 

 

 Go to Raster / Raster 
Calculator 

 Browse to your folder and 
give a name for the NDVI 

 Write the equation of NDVI 

 OK 

 Open the layer properties of 
your NDVI and go to 
Symbology tab 

 Select Render type = 
Singleband pseudocolor 

 Choose a Red to Green color 
ramp and a method of 
classification 

 OK  

  

https://scihub.copernicus.eu/
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5. Composing map layouts 

Map composition (layout) is realized in the Layout Composer. 

 

Exercise: Compose the map layout of neonatal mortality rate in Cambodia (number of deaths 
during the first 28 completed days of life per 1,000 live births in a given year or period)  

 

 First you need to render and symbolize your data in the map canvas as you want them 

to appear in a the map layout 

 

 Create a Print Layout 
o Project / New Print Layout… 
o Give a name to your layout and click OK 
o A right-click on the white page allows to open Page properties and set up the page size 

(for example A4 landscape) 

 

 Add your map: 
o Go to “Add item” Menu / Add Map or Click the button “Add a new map to the layout”  

 
o Draw the extent of map on your canvas 
o The map from your QGIS is displayed 

o Use the “Move item content” button  to move you map within its box 
o You can check “Lock layers” and “Lock styles for layers” to fix your map 
o You can redo add map to add a second one. Then, you need to go back to GIS main 

window to choose the display of your map canvas you want to show in the second map 

 

 Add a scale bar: 
o Go to “Add item” Menu 

/ Add Scale Bar 
o Place your scale bar on 

the map 
o When the scale bar is 

selected, you can 
adjust its properties in 
the Item Properties 
window 

o Choose the style of the 
scale par in “Main 
properties” 

o Choose the Units: here: 
1 km 

o Choose the number of 
Segments: here 50 
units 

o You can further adjust 
fonts, margins, etc. 
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 Add a legend: 
o Go to “Add item” Menu / Add Legend 
o Place your legend on the map 
o When the legend is selected, you can adjust its properties in the Item Properties window 
o In the Legend items: uncheck “Auto update” to remove some parts of the legend or 

reorder 
o You can double-click on a layer name to modify it 
o You can further adjust fonts, margins, etc. 
o You can uncheck background for a transparent one 

 

 Add a North arrow: 
o Go to “Add item” Menu / Add Picture 
o Place the picture on the map 
o In the “Search Directories”, look for a compass or North arrow 

 

 Add Text for title, sources, etc. 
o Go to “Add item” Menu / Add Label 

 

 

 

 Export maps: 
o In the Layout tab, should the export resolution (300 dpi is advised for fine printing) 
o Export as image or as pdf, depending on your needs 

 


